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E38 / E67 Custom Operating System Tutorial EFILive V7 Tuning Tool

Important — Please Read First

All Custom Operating Systems supplied by EFILive are provided “as is”
without warranty of any kind. Please take all reasonable caution when using
the extended features of EFiLive’s Custom Operating Systems.

This tutorial assumes you are running the software and firmware releases (or later)
listed below.

* EFILive Scan and Tune V7.5.6.99

» EFILive Black Box Logging and Reading V8.1.2.75

* FlashScan/AutoCal Firmware V2.06.16 (Oct 02, 2009)
» [E38/EG67 .calz file dates V7.33 (December 03, 2009)

Please ensure you are running the latest software & firmware. Free updates can
be downloaded from http://www.efilive.com/

To obtain the version number of the tuning software, go to the Help > About menu
option. You must have V7.5.6 build 99 or higher. Here you can also check the V2
firmware version under 'FlashScan V2 VIN licensing'.
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What is the EFiLive E38 / E67 Ethanol Custom OS?

EFILive’s E38 / E67 Custom ECM operating systems are modified versions of the
factory ECM operating system that gives users the ability to use the factory ECM
to perform functions beyond what was available in stock form.

The E38 / E67 ECM’s already offer amazing tuning functionality for a factory
computer. From ready to go 2.5bar SD tuning (with EFILive’s Virtual VE Table
technology) to variable camshaft control, even supercharger controls on the EG7.

The EFILive ethanol custom operating system enhancement works like so:

By applying 12V to a spare input on the ECM it forces the ECM to believe the car
is running 85% ethanol fuel, in doing so this allows the use of a whole range of fuel
and spark tables already in the factory programs. We've also added a second
Injector flow table in this mode to assist in alternate fuel situations.

These additional tables will assist tuners make the most of using alternate fuel
types such as LPG / Propane, or for racing applications using Nitrous injection.

These new functions combined with the already powerful functionality of these two
ECM'’s offers tuners amazing capabilities for a factory ECM negating the need for
an expensive aftermarket ECM.

Very Important:

This custom operating system upgrade is not recommended for
use on factory flex fuel vehicles if the owner still wants to run a
mix of Ethanol fuel and normal gasoline, please do not apply this
custom OS to any factory flex fuel vehicles without warning the
owner of this situation. The Ethanol percentage estimation
routines in the ECM are bypassed in this custom OS upgrade.

Northstar Engine, Please Read:

On E67 Northstar engines this upgrade may not be possible as
the factory tunes have none of the underlying Ethanol fuel
calibrations setup. Before updating to the custom OS check that
table B3671 does not have the same number through the entire
table. If it does then it is not possible to use that tune for this
upgrade.

Please carefully follow the steps on the following pages to successfully upgrade
your E38 / E67 ECM to the EFILive custom operating systems.
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Time to upgrade the ECM

Plug your V2 in to the USB port before starting the Tuning Tool.

Using the EFILive Tune Tool program you can either open the file to be converted

to the custom OS off your computer hard drive, or read the tune from the ECM (on

the vehicle or using a bench harness). To read the ECM, please follow below. Skip
to the next page if you are loading an existing file off the hard disk.

Read ECM icon:

NIrE Y s

Select either E38 or E67 ECM type to suit the vehicle:

Key: Contraller: | Gen V%8, W5 E38 ECM b

[ Try Alt Keys Zen Il LS1 9798 PCM

Gen Il L51 9908 PR

Gen v %8, Wi E38 ECMW
Gen V%A, VR, L4 BRT ECM
Tl st
Transmigsion B spd T43 TCM
LBY Durarmax Diesel ECH

LLY Durarmax Diesel ECH
LBZ Durarmax Diesel ECH
Lk Duramayx Diesel ECW
LEZ/LLY Allison TCK
LEZLMM Allison TCM

Inling B PCH

Atlas Engine 14, 15, 16 PCM
Yiorter 98-00 PCM

H7-02 4 Cylinder
(2-05 4 Cylinder
f thiir

[#] Use high speed

Gen IV V8, V6 E38 ECM selected.

Once the file has been read from the ECM you should save this as the stock file in
case you need to return the ECM back to standard.
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EFILive V7 Tuning Tool

With the tun file now in the editor, you need to click on the Tab that says -
“Upgrade O.S”. An E38 upgrade will be the example used below.

Calibration | %IN | Comments | Histary | Qut of Range | Modificatio

“Yehicle [dentifiers:

WI0: (B3 1EPSSH
Engine: | Gen-Iv' %a
Transmission: |BLA0E Auto

PC flash: |2Mb

Segment
¢ Operating System
¢ Engine Operation
¢ Engine Diagnostics
Mot used
Mot used
¢ Fuel Systam
¢ System
¢ Speedometer

Calibration |dentifiers:

Calibration; |12624488

Calibration Definition File (% cal):

D
12624402
H225430
§2223454

MIA,
MAA
H2223462
S226294
52223480

Upgrade O3

05 | 12624402 0% 0 | A4

Mame: |12624402 calz

“ersion:

Checksum
$1BAIF253
F11710047
P FORaC2C

T4,

T4,
f109CE3a7
FAF2DCAE4
FDDCFECER

BCC: [YRTM

Date:

Motes

Click this Tab

Select which operating system upgrade you wish to apply (only choose one if
multiple are shown), then click the “Apply Upgrade” button.

Calibration || %Ik Comments | Histary | Out of Range | Modifications | Upgrade 0% | Conversions

Select custom operating system:

Upgrade to Custom Operating

Apply Upgrade

Upgrades the current tun file to the EFILive E38 Custom Operating System Version #1.
Once this is applied, save as a new file.
Mow reopen the file and you will need to populate the new tables that have been added to suit your apg

Custom Calibrations" section.

VERY IMPORTANT: Only click the '‘Apply Upgrade' button once.
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Now save the file with a new name, File > Save As. Maybe something like
‘Joes Base Custom OS’

Or often some people might save the file base with the VIN like so
‘6G1EP55H19L123456 Base Custom OS’

Once the file has been saved with its new name you now need to close the file
down, File > Close Tuning File.

You then need to reopen the same file you just saved so EFILive will recognise
the file is a converted custom operating system, please also take note of the new
operating system number of the converted file once it opens.

Eg: we converted the factory OS 12624402, it is now 22624402
Please read the rest of this page very carefully.

EFILive automatically populates any new tables with some default maps during the
upgrade to get you started. On modified engines these values may not be suitable,
it is advised you copy your own table values in before running the engine.
Currently the two tables this applies to are -

A9972 "Injector Flow Base, Alternative Fuel On", please check it against the
injector flow table you are currently using and change to suit.

A9973 "P.E Mode Commanded Fuel, Alternative Fuel On", used on 2006-2007
model vehicles only, check the values are suitable for your application. This table
is not used for 2008+ model vehicles, use table B3670 instead.

There is also three calibrations that must be changed to enable switched ethanol
mode.

B0178 "Flex Fuel Option", change to 'Yes'

B0184 "Flex Fuel Sensor Type", change to 'Actual Sensor’
B0186 "Flex Fuel Sensor Diagnostic", change to 'No'

Finally adjust the following tables to suit the fuel type you are using.

B3671 "Stoichiometric AFR", change to suit the fuel type you are using when in
Ethanol mode, it may be set very rich from factory when at high ethanol content. If
using normal fuel then set the entire table to 14.68:1 AFR. Also check B0142 &
B0144 for values that match the fuel type you are using in Ethanol mode.

C6001 “DTC Type”, set P0169, P0178 & P0179 to 'X: Not Reported'
Now save the file.

This upgraded *.tun file will become your “base calibration” for the upgraded
Operating System. Always keep a copy of this file incase you need to restore your
ECM to its initial Custom Operating System state. Preferably, make a backup of it
onto a CD or USB memory stick and store it in a safe place or Email it to a friend.

The final step is to now do an entire ECM reflash with the new operating system
and calibrations. This is covered on the next page.
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Hints for in-vehicle ECM flashing:
» Ensure your vehicle is keyed to ON (not Accy), without the engine running.

* Ensure the battery is in a good state of charge.

You will need to perform a ‘Full Reflash’ of your ECM to use the newly created
custom operating system and calibrations. Once this completes successfully you
will only need to do ‘Calibration’ flashing for normal tuning procedures.

The EFILive Tuning Tool manual covers re-flashing procedures, it is highly
recommended you also refer to that document whilst performing this programming
procedure as this covers the correct steps for performing the full ECM flash and
how to go about ECM recovery should something go wrong.

With your custom OS file loaded press the button circled in the picture below.

CEIORXAE L MK

Once the full flashing procedure finishes (approx 4 - 5 mins) then turn off the IGN
for at least 15 seconds to allow all the vehicle modules to fully shut down.

Next, start the vehicle and ensure everything is running and operating correctly
(A/C, cruise control, etc).

Once these tests are complete you can wire up your map switching input. Without
the map switching input switch wired up the ECM will still be running off the normal
fuel maps.

It is highly recommended that you disconnect the vehicle battery before attempting
any wiring modifications.
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Wiring the map switching monitor ECM input

The ethanol switch monitor input is used to automatically select 85% ethanol fuel mode
in the ECM based on the state of a pin on the ECM.

Typical usage of this would be to monitor when a nitrous solenoid is switched on or
another alternative fuelling source that requires different fuelling / spark to standard fuel.
As these ECM’s already support E85 (Ethanol fuelling) it is not recommend this input be
used to compensate for actual ethanol fuelling as it does not indicate to the ECM any
other value apart from 85% ethanol.

The ECM connections are as follows —

For the E38

Connector 1 (Black) — pin 05 (shown below).
For the E67

Connector 1 (Blue) — pin 02.

The part number of these connector pins is 33467-0005/23
To activate the input apply 12V, to deactivate the input no voltage is fed to the pin.

You can monitor the ethanol percentage the ECM is using via the scantool PID
SAE.E85R, it should show 0% with the switch open and 85% with the switch closed.
The engine does not need to be running to view this, handy to check wiring before
starting the motor.

See the next few pages on pin installation.

ECM

C1, Pin5 o/ +12V

The input to the ECM
must only have 12V
when the activated
device to monitor is
switched on.
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First, disconnect the battery, never work on wiring with power active.

Locate the body or J1/X1 Connector for the ECM (E38 example shown below). It is the
73 pin connector. Note the arrow to cavity 5. Most unused cavities have either a blue
plug or a black plug that is moulded as part of the connector. Cavity 5 has the moulded

in plug. The cavity is blocked with this plug.

Cavity 5
Blue Cavity Plug

Ground Wire

Flip side of connector - terminal side where it plugs in to ECM socket.

Ground Terminal

Cavity 73 Cavity 5

Cavity 1
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A small screwdriver is used to break the black moulded in plug loose. Push on the edge
of the plug alongside the cavity wall for best leverage. It should break loose without too
much pressure if you push in the right place.

w

If your connector has the moulded in black plugs, they need to be removed from the
terminal area underneath the terminal separator. Use a small screwdriver at each end of
the separator to leverage it out. Cable end:

support@efilive.com -11 - www.efilive.com



E38 / E67 Custom Operating System Tutorial EFILive V7 Tuning Tool

Leveraging the other end to the cable side out. The separator needs a light push
upward to unclip it at each end.

Look into cavity 5 for the moulded in plug and remove it with a small tool. Though some
connectors may have no plugs, and open seals, this is unlikely.

Terminal 1

Cavity 5
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Terminal on the way in to the right cavity. Make sure it is oriented the right way around.
There is an open section in the terminal which needs to engage a locking tang once
pushed in.

Terminal all the way home on the connector side. Note a "click" when it is in the right
place as the tang clicks in to the terminal.

Terminal Installed in Cavity 5
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Connector with terminal separator re-installed. Only goes one way, with different sized
tongues on each end, and the ground terminal.

The E67 uses same connectors, but they only plug into an E67, however the process is
the same.

Thanks to lan from Isxworks for providing these photo's and text.

END OF DOCUMENT
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